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SphereEdit is software for Mac, Windows, and Linux for creating, editing, and exporting wavetables to be used 
with the Spherical Wavetable Navigator (SWN) Eurorack module from 4ms Company. The SWN can store up to 
108 user-created Spherical Wavetables, and SphereEdit is a powerful tool for designing Spheres and loading 
them into the SWN. 

SphereEdit is fork of the Synthesis Technology WaveEdit project developed by Andrew Belt. Both SphereEdit and 
WaveEdit are open-source under the GNU GPLv3 license. 
You can download the WaveEdit program for Mac, Windows, or Linux here: http://synthtech.com/waveedit 

https://4mscompany.com/SWN
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Basic terminology 
Waveform: A waveform is a timbre or a “sound”. In SphereEdit, each waveform is 512 samples long.  
   
Sphere: A Sphere is a bank of waveforms. A Sphere has 27 waveforms arranged in a 3x3x3 matrix. The 
Spherical Wavetable Navigator module (SWN) uses Spheres to organize its wavetables. 

Sphere File: A Sphere File is .wav file that contains the 27 waveforms of a Sphere. Sphere Files live on your 
computer and can be opened, edited, and saved by the SphereEdit program. You also can load a Sphere into the 
SWN by playing the Sphere File into the SWN while the SWN is in recording mode. If you’re curious about the 
details of the Sphere File format, open up a Sphere File using an audio editor program — you’ll see it's simply 
a .wav file containing each of the waveforms repeated 8 times.  

Quick Start: 
Creating a Sphere with SphereEdit 
1. Create a new Sphere by selecting New Sphere from the File menu.  

• Or, you can load a previously saved Sphere by selecting Open Sphere. 
• Or you can load a folder containing 27 .wav files by selecting Load Waves from Folder…. The files must 

be named 00.wav, 01.wav, 02.wav, …, 26.wav 
• Or, you can load individual .wav files into each of the slots by clicking a slot on the left, then selecting 

Open single Wave from the Edit Menu. 
2. Create 27 waveforms using the SphereEdit tools: 

• Draw and edit waveforms with the Pencil, Brush, Grab, Line, and Eraser tools 
• Draw and edit harmonics using the same tools 
• Load primitives from the Digital/Analog/FM/Glitch categories 
• Apply Effects to waveforms, individually or spread across multiple waveforms 

3. (Optional) When you have 27 waveforms that you like, save the Sphere by selecting Save Sphere from the 
File menu. This creates a Sphere File, which is a .wav file containing all your waveforms. 

Loading a Sphere into the SWN 
Loading your work in SphereEdit into the SWN is done by playing the Sphere into the SWN while the SWN is in 
recording mode. 
1. Make sure your computer system’s volume is at maximum. 
2. Plug your computer’s audio/headphone output jack into the SWN’s Waveform In jack. Use a mono 

1/8” (3.5mm) cable to plug into the SWN. If you are also monitoring the computer’s output, turn the speaker 
volume down because the transferring process automatically boosts the volume of SphereEdit. 

3. Enter Sphere Recording Mode on the SWN (see SWN User Manual). 
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4. Press the flashing red record button on the SWN. The SWN flash the red light by the Waveform jack to 
indicate it’s waiting to detect a signal before recording. 

5. Click the Play into SWN button in SphereEdit. The computer will play your Sphere and the light ring on the 
SWN should fill up with red lights to show the progress. It should stop playing after 2.5 seconds. 

6. When it’s done, turn the SWN’s Browse knob to hear your new Sphere. 
7. Save the Sphere on the SWN if you want to keep it (see SWN User Manual). 

Toolbar 

The toolbar is at the top of every screen and contains the playback controls as well as tabs for the different pages. 

Play: Check this box to play the current waveform out your computer’s audio output. If you don’t hear any sound, 
verify you’ve selected the correct audio interface from the Audio Output menu. Pressing the spacebar on the 
computer also toggles playback. 
Play into SWN: Click this button to load the current Sphere into a SWN that’s in recording mode and connected 
to the computer via an audio cable. 
Volume: The playback volume. 
Frequency: The frequency that waveforms will be played from 1Hz to 10kHz. Note: some sound cards will glitch 
and stop outputting if the slider is set too high. If this happens, save your work and restart SphereEdit. 
Morph Interpolate: Check the box to interpolate (morph) between waveforms. Uncheck it to “snap” to exact 
waveforms without morphing in between them. To hear this in action, turn on Play and drag the Browse slider. 
Browse: Drag the slider to select which waveform is being played (or which two waveforms are being morphed 
together if Morph Interpolate is turned on. This slider does the same thing as the Browse knob on the SWN 
module.  
Browse Speed: If this slider is not at zero, the Browse setting will automatically be changed when Play mode is 
on. This is similar to patching a slow ramp-up LFO into the Browse CV jack of the SWN. 

Grid View Sliders 
In Grid View, the Browse and Browse Speed sliders change to four sliders: 
Depth: Controls the position of the current waveform in the Depth direction (0 to 3). Can also be controlled by the 
Left/Right arrow keys on the keyboard. 
Latitude: Controls the position of the current waveform in the Latitude direction (0 to 3). Can also be controlled by 
the Up/Down arrow keys on the keyboard. 
Longitude: Controls the position of the current waveform in the Longitude direction (0 to 3). Can also be 
controlled by the Page Up/Page Down keys on the keyboard. 
Keyboard Step Size: Controls how far the position moves when pressing the arrow or Page Up/Page Down keys 

Tabs 
The tabs select which of the five pages is active: Waveform Editor, Effect Editor, Grid View, Waterfall View, or 
Import. See the following sections for a description of each page. 
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Waveform Editor 

The Waveform Editor page allows you to directly edit waveforms samples and/or harmonic content. Effects can 
be applied to an individual waveform. 

Tools: 
Select one of the tools (Pencil, Brush, Grab, Line, Eraser) and click and drag on the waveform. You also can use 
the tools on the Harmonics section to adjust the waveform in the frequency domain. Editing either section 
(Waveform or Harmonics) will immediately update the other section. If you have Play turned on, you will also hear 
the resulting waveform live as you edit. 

• Pencil: Draw samples and harmonics directly. 
• Brush: Smoothly adjust adjacent samples depending on the amount of time the mouse is held. 
• Grab: Adjust a single sample or harmonic. 
• Line: Draw a straight line by dragging. 
• Erase: Set samples and harmonics to zero as you drag across them. 

Clicking the Clear button will erase the entire waveform. 
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Load Primitive: 
Below the tool selection are four drop-down menus that allow you to load single waveforms from a library of useful 
shapes. Selecting one will replace your current waveform. These files are located inside the SphereEdit directory, 
in a folder named “catalog”. You can customize these preset waveforms by adding .wav files with 512 samples to 
a subfolder in the catalog directory. You can even create new subfolders, optionally prefixing the folder or file 
names with numbers to sort them. Note: On macOS, the catalog folder can be found by control-clicking on the 
SphereEdit application icon, selecting Show Package Contents, and then opening the Contents folder and then 
the Resources.  

Waveform Browse Sidebar: 
The sidebar shows all 27 waveforms. The currently selected waveform has a different background than the 
others.  You can click on a waveform to select it, or drag in the display to browse through the waveforms (playing 
them as you drag, if Play is turned on). A circle in the sidebar indicates where the current Browse position is 
(which is what is being played). 

If Morph Interpolate is turned on, then the circle may be in between two waveforms, which means that both 
waveforms are being blended together to produce the output. The Browse slider will show a value that’s between 
two integers (ie 14.722). However, only one waveform can be selected for editing at a time. Double-clicking a 
waveform in the sidebar will force Browse to jump to that waveform exactly (without morphing between it and a 
neighboring waveform). 

You can use the Cut/Copy/Paste menu items in the Edit menu to move and copy waveforms. You also can right-
click on a waveform to show a context menu with similar options as the Edit menu. If you click on a waveform and 
then control+drag to a new spot, you will copy it. If you click on a waveform and then shift+click on another 
waveform, the range of waveforms will be selected and can be Cut/Copy/Pasted. 

Effects: 
Below the Waveform and Harmonics display areas are a series of sliders for the effects. 

• Pre-gain: Adds gain to the signal before applying the rest of the effects. 
• Phase Shift: Control the phase of the waveform, shifting it in time and wrapping the end around to the 

beginning. This doesn’t have much of an effect on the sound of a single waveform but it can have a big 
impact on how waveforms morph together. 

• Harmonic Shift: Rotates the phase of each harmonic equally. Also doesn’t effect a single waveform’s 
sound, but changes how waveforms morph (and how later effects will sound when applied). 

• Comb Filter: Copies and delays the waveform with feedback. This is similar to using a very short delay 
effect processor. The volume level may decrease significantly with this effect, depending on your 
waveform, so it is useful to apply pre- or post-gain or to Normalize the final signal. 

• Ring Modulation: Multiplies the signal by a sine wave at an adjustable frequency. 
• Chebyshev Wavefolding: Smooth wavefolding effect by increasing the level of small samples and folding 

samples back when they reach the clipping point. 
• Sample & Hold: Keeps the sample constant for an adjustable amount of time, resulting in a stepped 

wavetable and extra higher harmonics. 
• Quantization: Reduces the bit-rate of the waveform, giving a similar stepping effect as Sample & Hold. 
• Slew Limiter: Limits the maximum difference between adjacent samples, resulting in a sort of lowpass 

filter in some cases and a source of higher harmonics in others. 
• Lowpass Filter: Applies a brick-wall filter to filter harmonics higher than an adjustable threshold. 
• Highpass Filter: Does the same but filters low harmonics. 
• Post-Gain: Applies gain to the final post-processed signal. 

Each effect can be applied independently by dragging the slider. The Waveform display shows dots where the 
actual sample value is in the wavetable (pre-effects), and a line to represent the waveform after the effects are 
applied. 

At the bottom are five controls to help with the effects: 
• Normalize: automatically adjusts the final gain and DC offset for maximum amplitude. 
• Cycle: Reduces the "jump" from the last sample to the first when the wavetable is cycled by applying a 

gradual slope to all of the samples. 
• Randomize: Sets the effect sliders to random values, which can be helpful when you need inspiration. 
• Reset: Sets all effect magnitudes to zero but leaves the pre-processed waveform intact. 
• Bake: Applies the post-processed waveforms to become the new pre-processed waveforms, and sets all 

effect magnitudes to zero. The solid line will turn to dots. 
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Note: The values of the dots are what are saved to the .wav file, but the lines will be approximately what you hear 
at audio frequencies. The "wiggles" are a result of the Gibbs phenomenon when applying a brickwall lowpass filter 
to the digital samples at the Nyquist frequency. This is why wavetables do not sound "stepped" when passed 
through a digital-to-analog converter. 

Effects Editor 

The Effects Editor allows you to apply effects across a series of waveforms. It’s easy to steadily increase or 
decrease an effect amount as a Sphere is browsed, or to see all the effects of all 27 waveforms on one screen. 

For each effect, you can set the average value of the effect of all wavetables at once using the horizontal 
Average slider. Below that are 27 vertical bars where you can adjust the actual amount of the effect for each 
waveform. The same Pencil, Brush, Grab, Line, and Eraser tools from the Waveform Editor page are at the top 
of the page. See the Waveform Editor section for details on each effect. 
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Grid View 

The Grid View allows you morph between the 27 waveforms of the Sphere in three dimensions, similar to how 
navigation works on the SWN module. 
The page shows three 3x3 grids of waveforms side-by-side. Each waveform is labeled with a number (0-26) 
which is the same number used on the Waveform Editor sidebar and the Effect Editor page. Following this 
number is a triplet of numbers such as (1,2,0). These indicate the Latitude, Longitude, and Depth position within 
the 3x3x3 Sphere.  
Clicking on a waveform will move the Depth/Latitude/Longitude position to that waveform. You also can drag your 
mouse around to preview what it sounds like to morph in any direction. Morph Interpolate works the same on 
this page as it does in the Waveform Editor sidebar (see section above), snapping to exact waveforms when 
turned off and blending between neighboring waveforms when turned on. However, on this page morph works in 
three directions, between all eight neighbors (two in each dimension). Notice that as you drag your mouse there is 
a circle that follows it, and two other outlines of circles that appear in the other two 3x3 grids. These are a way of 
visualizing a three-dimensional surface on a two-dimensional screen. If you can imagine that each 3x3 grid is 
“stacked” on top of the next 3x3 grid to create a cube, you’ll see that the three circles will always line up. 
If you drag the Longitude slider (or press Page Up or Page Down), the circle will fade from one 3x3 grid to 
another. This illustrates the three-dimensional nature of this view. 
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Waterfall View 

Waterfall View is another way to visualize the 27 waveforms of a Sphere. There are two sliders:  
• Scale: Adjusts how high each waveform is drawn (amplitude). 
• Angle: Adjusts the viewing angle 
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Import


The Import page is useful for creating banks from audio files you already have in your collection. To import an 
audio file, click Browse near the top. Only .wav files can be imported, and they must be a reasonable length, 
approximately between 32 and 16,000,000 samples. 

Once loaded, the waveform of the audio file will appear in the upper Imported Audio Preview display. 
The lower Bank Preview display shows all 27 consecutive wavetables in the Sphere. 
The following sliders and controls are at the bottom:  

• Gain/Reset Gain/Normalize: Adjust the volume of the audio file before importing. 
• Offset: Adjusts the horizontal position of the audio file when placed in the Sphere. You also can change the 

Offset by clicking and dragging the waveforms. 
• Zoom: Stretches the file by slowing down or speeding up the time. 
• Zoom 1:1: Sets the zoom level to 100%, corresponding to equal-sample matching between the bank and 

imported audio.  
• Zoom Fit: Sets the zoom so that the audio file stretches exactly to the size of a Sphere. 
• Snap to Power of 2: Locks the zoom level to ...12.5%, 25%, 50%, 100%, 200%, 400%, 800%, and so on. 

This is useful when importing wavetables from other software with different wavetable sizes. 
• Left Trim/Right Trim: Cut away the imported audio by a certain amount to restrict it to a range of 

wavetables.  
• Snap Trim :Snaps the trim numbers to integers, so no partial waveforms are trimmed. 

You can mix the imported audio into your existing Sphere with the following methods: 
• Replace All: Overwrites the entire Sphere with the imported audio after clicking Import. 
• Replace Partial: Clears only the portion of the Sphere overwritten by the audio before importing. 
• Mix: Sums the existing Sphere with the imported audio. 
• Ring Modulate: Multiplies the existing Sphere with the audio. Note that the waveforms outside the audio's 

position are cleared, since the samples are multiplied by the audio at that point, which is zero. 

Finally, click Import to finalize the parameters to continue working on the bank in other pages, or Clear to unload 
the audio and start over. 
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File Menu 
New Sphere: Create a blank slate of 27 waveforms.  
Open Sphere…: Open a Sphere file that you’ve previously saved. 
Save Sphere: Save your latest changes to the currently open Sphere file. 
Save Sphere As…: Save the current Sphere as a new file. 
Save Waves to Folder…: Saves the current Sphere as 27 separate .wav files into a folder. The files will be 
named 00.wav, 01.wav, 02.wav, etc… 
Load Waves from Folder…: Loads 27 .wav files from a folder, and creates a new Sphere using these 
waveforms. The .wav files must be named 00.wav, 01.wav, 02.wav, etc… They also must each be 512 samples 
long and 16-bit/44.1kHz/mono. One use for this would be to export a Sphere using Save Waves to Folder, then 
applied batch processing to each waveform in another audio editing program, and then re-imported them using 
this command. 

Edit Menu 
Undo: Undo the last action. 
Redo: Redo the last undo. 
Select All: Selects all the waveforms in the Sphere. Only visible on the Grid and Waveform Editor pages. 
Clear: Clears the selected waveform(s). 
Randomize Effects: Sets random effect values to the selected waveforms(s). 
Cut/Copy/Paste: Cuts, copies or pastes the selected waveform(s). 
Open Single Wave…: Allows you to load a single .wav file into the selected waveform slot. If the .wav file is 
longer than 512 samples, only the first 512 samples will be loaded. 
Save Single Wave As…: Allows you to save the selected waveform as a 512 sample .wav file. 

Audio Output Menu

The Audio Output menu is populated with every audio interface that SphereEdit detected. Select your preferred 
audio interface to route SphereEdit’s audio there. 

Colors Menu 
Select a color scheme (skin) to applied to the GUI of SphereEdit. The change will take effect immediately and the 
most recent selection will be loaded the next time you launch SphereEdit. 

Help Menu

About SphereEdit: Shows credits and info regarding this application. 
Manual PDF: Opens this document in your system’s PDF viewer. 
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